
The QuickShelf Toolbar Contents
QuickShelf is a floating Toolbar that consists of    several buttons you can click to look in the 
Bookshelf Tables of Contents or perform full-text searches using Bookshelf's Find feature. 
QuickShelf is located at the top of your other Windows applications, near the title bar. Move 
the mouse pointer slowly over the QuickShelf Toolbar to pop up the name of each button.
When you first install Bookshelf, QuickShelf consists of buttons for Encyclopedia Contents 
and for Dictionary Contents, plus the QuickShelf menu button at the far right. You can click 
the menu button to see choices for organizing QuickShelf to your own specifications. 
QuickShelf is designed to be customized to suit your needs. The first thing you'll probably 
want to do is add    buttons for the books you use most regularly, to increase QuickShelf's 
look-up power.
When you click the QuickShelf menu button on the right you will see the following 
commands: Customize, QuickShelf Keys, Help, About Microsoft QuickShelf, and Exit. Click a 
command to choose it.
 The Customize command opens the Customize dialog box, where you can add books and 

features to QuickShelf in the Toolbar Tab. Click the View Tab to change some of the settings 
in QuickShelf, such as the size of the buttons on the Toolbar.
 The QuickShelf Keys command opens the QuickShelf Keys dialog box, where you can create

custom key combinations to make using QuickShelf even faster.
 The Help command opens Help for QuickShelf.
 The About Microsoft QuickShelf gives you basic information about the product, including 

copyright information.
 Exit closes the QuickShelf Toolbar.

 A right-click on the QuickShelf Toolbar displays a shortcut menu. The Customize 
command is the same as the Customize command on the QuickShelf menu. A click on one of
the button commands changes the size of your QuickShelf buttons. The Minimize command 
reduces QuickShelf to an icon. The Help command displays QuickShelf Help.
For more information, click a topic:

Accessing Bookshelf from Other Applications Using QuickShelf
QuickShelf Customize Dialog Box Description
QuickShelf Keys Dialog Box Description



Accessing Bookshelf from Other Applications Using QuickShelf
You can click a button on the QuickShelf Toolbar while you are working in another Windows 
application (such as Microsoft Word for Windows) to look up words and phrases in any book 
in Bookshelf. 
For example, while writing a proposal in Word, you can use QuickShelf to look up a synonym 
for a word in the thesaurus.
 QuickShelf can either look up the word you want in the Table of Contents in a specified 

Bookshelf book or all of Bookshelf's books. 
 QuickShelf also can use the Find feature to perform a full-text search for the selected text 

within a specified book or all books.
A Floating Toolbar
QuickShelf is a floating Toolbar that appears near the title bar of your Windows applications. 
With QuickShelf, you highlight a word or phrase in another Windows application, and then 
click a QuickShelf button to look it up in Bookshelf. QuickShelf comes with buttons for 
looking up words and phrases in the dictionary and the encyclopedia--plus, you can add 
more buttons, so you can use Contents and Find to look in all the Books in Bookshelf, from 
any other application.
Always Available
When you set up Bookshelf, you also set up QuickShelf. Setup places the QuickShelf icon in 
your Startup Window in Windows Program Manager; this means that QuickShelf starts every 
time you start Windows on your computer. To change the location of the QuickShelf icon in 
Windows Program Manager, consult your Windows documentation.
 Familiarize yourself with QuickShelf by moving the mouse pointer slowly over it to pop up 

the names of the buttons.
To add buttons to the QuickShelf Toolbar:
1. Click the button at the far right of the Toolbar to display the QuickShelf menu.
2. Click the Customize Command.
3. In the Customize dialog box, click the Toolbar Tab, if necessary.

This is where you select the books you want to add to the Toolbar, and the feature--either 
Contents or Find--you want to use to look things up in them.

4. Click as many boxes as you want to add books and features. (Click an    X    to delete the 
book and feature, if you change your mind.)
Each click adds a button to the Toolbar. A button for a book using the Contents feature 
has a book icon. A button for a book using the Find feature has a book and magnifying 
glass icon.

5. Click OK to save your changes and close the box. (If you don't want to make changes at 
this time, click Cancel.)
Look at the QuickShelf Toolbar, you will see the new buttons.

 A right-click on the QuickShelf Toolbar displays a shortcut menu. The Customize 
command is the same as the Customize command on the QuickShelf menu. A click on one of
the button commands changes the size of your QuickShelf buttons. The Minimize command 
reduces QuickShelf to an icon. The Help command displays QuickShelf Help.
To use the QuickShelf Toolbar:
1. In another Windows program, select a word or phrase.
2. Move the mouse pointer over the buttons on the QuickShelf Toolbar to locate the book you

want to look in and the feature you want to use.
3. Click a button on QuickShelf. If Bookshelf is not open, QuickShelf will open Bookshelf for 

you and look for your word or phrase.
If you click a Find button, you will see a message that lets you know Bookshelf is 



searching for your word or phrase.
4. Bookshelf opens to the book you were looking in. 
 If you used the Contents feature, the Contents Tab opens with your word or phrase in the 

text box and the article on your word or phrase displayed in the Article Window.
 If you used the Find feature, the Find Tab opens with your word or phrase in the text box, 

and the list of articles that contain your word or phrase in the list box. The first article on the
list is displayed in the Article Window.
5. In either Tabbed List box, click an item on the list to jump to a Bookshelf article.
6. To return to the other application, click the Control-menu box in the upper-left corner of 

Bookshelf, click Switch To, click the other application's name in the list, and then click the 
Switch To button.

To use key combinations:
1. In another Windows application, select the word or phrase you want to look up in 

Bookshelf.
2. Press the key combination that will use the Contents or the Find feature to look through a 

book or all Bookshelf books.
A key combination consists of two or more keys that you specify in the Key Combination 
Definitions box. For more information see "Setting Options for Key Combinations."
If Bookshelf is not open, QuickShelf will open Bookshelf for you and look for your word or 
phrase. 

    If you select more than one word, and then press a key combination that uses the Find 
feature, QuickShelf looks for the whole phrase, not for each separate word in the phrase. For
example, if you were looking for "a little something," QuickShelf would look for instances 
where the phrase "a little something" appears, not for instances of the separate words "a," 
"little," and "something."
3. Depending on whether you used a key combination with the Table of Contents or the Find 

feature the following will occur:
 If you used a key combination to look through a Bookshelf Table of Contents, the Contents 

Tabbed List box will appear, with article titles that match your word or phrase. (If there is no 
match, the Contents Tabbed List will appear with entries that come close to matching your 
word or phrase.) 
 If you used a key combination with the Find feature, the Find Tabbed List will appear with a 

list of all the articles that contain your word or phrase. (If no articles were found, a message 
will let you know.)
4. In either Tabbed List box, click an item on the list to jump to a Bookshelf article that 

contains your word or phrase.
5. To return to the other application, click the Control-menu box in the upper-left corner of 

Bookshelf, click Switch To, click the other application's name in the list, and then click the 
Switch To button.

See Also
QuickShelf Customize Dialog Box Description
QuickShelf Toolbar Contents
QuickShelf Keys Dialog Box Description



 The QuickShelf Customize Dialog Box Description
The Customize dialog box is where you tailor QuickShelf to your specific needs. You can 
customize the QuickShelf Toolbar to look things up in the books you use most. You can also 
choose to look things up using Contents or Find or both. In addition, you can reset QuickShelf
options to make the buttons larger, or turn off the ToolTip popups, or hide QuickShelf. 
The Customize dialog box consists of two tabs--the Toolbar Tab and the View Tab. The Toolbar
Tab is the default. It's where you add buttons to the Toolbar. Click the View Tab to change the
other QuickShelf settings, such as the size of the keys.
To customize the QuickShelf buttons on the Toolbar:
1. Click the button at the far right of the Toolbar to display the QuickShelf menu.
2. Click the Customize command.
3. In the Customize dialog box, click the Toolbar Tab, if necessary.

This is where you select the books you want to add to the Toolbar, and the feature--either 
Contents or Find--you want to use to look things up in them.

4. Click as many boxes as you want to add books and features. (Click an    X    to delete the 
book and feature, if you change your mind.)
Each click adds a button to the Toolbar. A button for a book using the Contents feature 
has a book icon. A button for a book using the Find feature has a magnifying glass and 
book icon.

5. Click OK to save your changes and close the box. (If you don't want to make changes at 
this time, click Cancel.)
Look at the QuickShelf Toolbar, you will see the new buttons.

To customize the look of QuickShelf:
1. Click the button at the far right of the Toolbar to display the QuickShelf menu.
2. Click the Customize command.
3. In the Customize dialog box, click the View Tab, if necessary.
4. Change the Toolbar Button Size by clicking one of the button options. A dot appears. (To 

remove the button option, just click the dot.)
5. To hide the Toolbar, click the X next to Toolbar is Always Visible. (To always have 

immediate access to the Toolbar, click the check box again. The X will appear.)
The Toolbar will not disappear if you click the X next to Toolbar is Always Visible, but it 
may get covered by other Windows applications as you use them. To see the QuickShelf 
Toolbar, hold down the ALT key and press TAB until it appears.

6. To turn off the ToolTips (the names that pop up as you move the mouse pointer over the 
buttons) click the X next to Show ToolTips. 
To show the ToolTips again, just click the check box again. The X will appear.

7. To save all your changes and close the box, click OK. (To close the box without making any
changes, click Cancel.)

 A right-click on the QuickShelf Toolbar displays a shortcut menu. The Customize command 
is the same as the Customize command on the QuickShelf menu. A click on one of the 
button commands changes the size of your QuickShelf buttons. The Minimize command 
reduces QuickShelf to an icon. The Help command displays QuickShelf Help.

See Also
Accessing Bookshelf from Other Applications with QuickShelf 



QuickShelf Keys Dialog Box Description
In the QuickShelf Keys box, you can set options for key combinations you use with 
QuickShelf. The books are listed on the left. (Note that All Books is on this list, which gives 
you the opportunity to create a key combination that will look in all books.) 
Text boxes for Contents or Find key combinations appear across from each book. Use the 
Contents edit boxes to create key combinations that look through the Table of Contents of a 
Bookshelf book from another windows application. Use the Find edit boxes to type key 
combinations that will have the Find feature look through specific Bookshelf books from 
another windows application.
 If you assign a QuickShelf key that is the same as a keyboard shortcut, such as CTRL+C (for 

copying) or CTRL+P (for printing), the QuickShelf key will override the keyboard shortcut.
For more information on using the key combinations that you set, see "Accessing Bookshelf 
from Other Applications Using QuickShelf."
To set options in the QuickShelf Keys dialog box:
1. Click the far right QuickShelf button, and from the QuickShelf menu, choose QuickShelf 

Keys.
The QuickShelf Keys dialog box opens.

2. Delete a key combination by moving the pointer to the Contents or Find text box that 
contains the combination you want to delete, clicking an insertion point, and then 
pressing the SPACEBAR.

3. Add a key combination by moving the pointer to the Contents or Find text box in which 
you want to add the combination, clicking an insertion point, and then simultaneously 
pressing the keys for the combination you want.
Generally, the keys you choose should have at least one modifier, such as SHIFT, ALT, or 
CTRL (the SHIFT or ALT key alone is not valid); see the default key combinations for 
examples. However, if you choose a key or a key combination that isn't valid because it 
doesn't have a valid modifier, Bookshelf will automatically add the CTRL key as a modifier. 
For example, if you press X, ctrl + x will appear in the text box. Or, if you press SHIFT + F2, 
CTRL + SHIFT +F2 will appear in the text box.

The following keys and key combinations cannot be used as valid key combinations:
    F1 and F10
    SHIFT or ALT alone in combination with another key
    CTRL+ALT+DEL
    CTRL+ALT+SHIFT+DEL
    ESC, PRINT SCREEN, PAUSE, ENTER, SPACEBAR, TAB
    The following characters: ( )    - + [ ] \ ; , /

4. Be sure there is an X in the Enable QuickShelf Keys check box in the lower-left corner. If 
there is no X, click the check box to enable it. (To disable QuickShelf Keys, click the X.)

5. Click Close to save your changes and close the dialog box.
See Also
Accessing Bookshelf from Other Applications with QuickShelf
QuickShelf Customize Dialog Box Description
QuickShelf Toolbar Contents



click
To press and release a mouse button once, usually the left mouse button.



full-text search
A search for a word or phrase through the entire text of every article in the open book, or in 
all books (depending on the search criteria you choose). When you use the Find Tab or the 
Advanced Find command on the Tools menu, you perform a full-text search. Doing a full-text 
search is different than looking in the Table of Contents, using the Contents Tab. When you 
use Contents, you look through the Contents List, not the entire text of articles.



icon
A miniature picture that represents something, such as a program in Windows Program 
Manager. Double-click an icon to open the program. Icons in the Program Manager Startup 
Window start automatically when you start Windows.
Icons also represent books and features on the QuickShelf Toolbar buttons. Click a button 
with a book icon to look up your word or phrase in that books Table of Contents. Click a 
button with an icon of a magnifying glass and book to use the Find feature to perform a full-
text search on your word or phrase.



jump
To move rapidly to another article. When you click hot text (or jump text) you jump to 
another article in Bookshelf.



pop-up 
When you move the mouse pointer over icons and unlabeled buttons you will pop up a label 
for the icon or button. This label is called a tooltip.



Program Manager
Your home base for using Windows and starting applications. When you start Windows, the 
Program Manager window is open on the desktop.



title bar
The horizontal bar at the top of a window that contains the title of the window. On many 
windows, the title bar also contains the Control-menu box and Maximize and Minimize 
buttons. Boxes also have title bars.




